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ABOUT THIS MANUAL

This is the Owner’s Guide for the UMAX Astra 2000U and the
Astra 2000P scanners. It will provide information you will need to
operate your scanner, as well as show you how to use the software
that comes with it.

This manual assumes you have a basic knowledge of personal
computers, and scanning terms and functions. However, a glossary
of scanner terms is included at the end of this guide to explain the
scanning terms used throughout this guide.

The information in this manual is organized as follows:

Chapter 1. Getting Started
Chapter 1 introduces you to the Astra 2000 series scanner and tells
you how to install the scanner hardware and software.

Chapter 2. Your First Scan

Chapter 2 steps you through the basic procedures to use the
scanner. These steps include scanning an image, and saving an
image to a specified location.

Chapter 3. Scanning Basics

Chapter 3 describes the VistaScan software and other scanning
utilities that have been included with the scanner to provide worry-
free scanning. The VistaScan software includes several features that
make scanning images and text easier than ever.

Chapter 4. Scanning Projects

Chapter 4 explains how to use this scanner with the bundled
software applications. It shows you how to use the scanner for
creative projects like making photo albums and calendars, sending
scanned images via e-mail, and using the text recognition program
to scan a document into your word processor.



Chapter 5. How to Get Help

Chapter 5 contains information you can refer to when you need
assistance with the scanner or the bundled software. The
information includes: how to access the online manuals for all the
bundled software, troubleshooting guidelines, and how to contact
the manufacturer for additional assistance.

Glossary
Includes definitions of common scanning terminology.
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CHAPTER 1. Getting Started

Introduction

Thank you for purchasing the UMAX Astra 2000U or Astra 2000P
scanner. These versatile units are perfect for the home or office.
Use these scanners to add variety and flair to your documents, or to
help you share images with others.

The hardware connection is the only difference between the two
scanners. The Astra 2000U scanner is equipped with a USB
connector that allows you to make a fast and easy connection to the
USB port on your PC, or USB-equipped Macintosh computer (such
as the iMac or G3). The Astra 2000P scanner uses a parallel
connector that simply plugs in to the parallel (printer) port on your
Windows PC. Throughout this guide the scanners will be referred
to as the Astra 2000 scanner unless specified otherwise.

In addition to being easy to connect, these scanners are also easy to
use. Simply follow the instructions in this guide and you’ll be
scanning in no time. With the powerful software included with your
scanner, you can create an archive of scanned images, e-mail or fax
images to friends or clients, or create your own web site gallery.
Get ready to unleash your creativity with the UMAX Astra 2000
scanner.

Unpacking the Scanner

Your scanner package includes the cables and software you need to
get the scanner up and running. The scanner package should
contain all of the items listed below. If you do not find all of the
listed items, contact the retailer from whom you purchased the
scanner, or contact UMAX. For information about contacting
UMAX directly, refer to Chapter 5. How to Find Help.



Astra 2000U Package Contents

*  UMAX Astra 2000U Flatbed scanner
e USB Interface Cable
e Quick Start Guide and Owner’s Manual
*  Power Adapter
«  Adobe® PhotoDeluxe® Home Edition 3.0 CD-ROM (PC
version)
«  Adobe® PhotoDeluxe® 2.0 CD-ROM (Macintosh version)
* UMAX Scanner CD-ROM which contains:
* UMAX VistaScan
* VistaAccess
» VistaShuttle (PC only)
« Caere® OmniPage® LE OCR
«  NewSoft® Presto! PageManager
«  NewSoft® Presto! PhotoAlbum™ (PC only)
«  NewSoft® Presto! Type™ (PC only)
UMAX Copy Utility (PC only)

Astra 2000P Package Contents

UMAX Astra 2000P Flatbed scanner
» Parallel Interface Cable
e Quick Start Guide and Owner’s Manual
»  Power Adapter
«  Adobe® PhotoDeluxe® Home Edition 3.0 CD-ROM
UMAX Scanner CD-ROM which contains:
UMAX VistaScan
» VistaAccess
* VistaShuttle
« Caere® OmniPage® LE OCR
«  NewSoft® Presto! PageManager™
«  NewSoft® Presto! PhotoAlbum™
«  NewSoft® Presto! Type™
«  UMAX Copy Utility

10
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Getting to Know Your Scanner

To gain a complete understanding of the information contained in
this manual, it is important that you become familiar with your
scanner. The graphics below identify the key scanner components.

Document Cover
The plastic cover that protects the
object glass.

Object Glass

The glass surface on which Power Indicator

documents or images are llluminates to
placed. indicate that the
scanner is
powered on.

Astra 2000U and Astra 2000P Scanner Elements

4-Pin USB Connector __ %~
= Power Adapter

Receptacle
R —

—

Astra 2000U Backpanel

11
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Power Adapter
Receptacle

Parallel Interface

Parallel Interf
Connector "TO PC” arallel Interface

Connector "TO
Printer”

Astra 2000P Backpanel

There are two parallel ports on the Astra 2000P scanner. This
allows your printer and your scanner to communicate with your
computer using the parallel connector. The first parallel port is used
to connect the scanner to your computer. You attach your printer
cable to the second parallel port, which acts as a pass-through port.

System Requirements

This section defines the minimum system requirements necessary to
operate either the Astra 2000U or Astra 2000P scanner. Please refer
to the section below that applies to your scanner and computer type.

Astra 2000U Scanner
PC Requirements

e An IBM-compatible PC with 80486, Pentium processor or
higher

«  Microsoft® Windows 98, 95 OSR 2, or higher

* USB interface connector

e Atleast 16 MB RAM memory (32 MB recommended)

* CD-ROM drive

e 170 MB of available hard disk space

12
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Macintosh Requirements

e iMac or USB-compatible Macintosh

e Macintosh OS 8.1 or higher

» USB interface connector

e Atleast 16 MB RAM memory (32 MB recommended)
* CD-ROM drive

e 170 MB of available hard disk space

Astra 2000P Scanner

* An IBM-compatible PC with 80486, Pentium processor or
higher

«  Microsoft® Windows 98, 95 OSR 2, NT 4.0 or higher

» Parallel interface connector

e Atleast 16 MB RAM memory (32 MB recommended)

 CD-ROM drive

e 170 MB of available hard disk space

Installing the Hardware

After you have removed the scanner from the box and verified that
all of the package contents have been included, please check to
make sure that your computer is compatible with the scanner’s
connectors.

About Scanner Connectors
USB Connectors

Many newer computers, including most PCs, the Apple iMac, and
USB capable Macintosh computers rely on USB technology as the
primary method of communication between the computer and its
peripherals. With this new USB “plug-and-play” technology, your
computer automatically configures any recently attached
peripherals (such as a mouse or a scanner) as soon as you reboot the
computer.

13



If your computer has a USB port, you must make sure that this port
is enabled in the system BIOS. Please refer to the troubleshooting
section to learn more about enabling the USB port.

Parallel Port Connectors

Another common communication interface is the parallel port. The
parallel port interface is the standard method for connecting a
printer to a PC computer. In order to use the Astra 2000P scanner,
you must make sure that the mode of your parallel port is set
correctly. Please refer to the troubleshooting section of this manual
to learn how to correctly set the port mode.

Checking Your Computer’s Connectors

To use your scanner you need to understand what type of
connectors you have on your computer. To determine the connector
type, look at the back panel of your computer:

A USB port is a small slot %42” long and ¥4 wide.

e A Parallel port is about 1 %" long and ¥ wide, with two rows
of tiny holes (25).

NOTE: If your computer has a USB port, check to make sure that
your computer's operating system supports USB. The following
factory-installed operating systems support USB: Microsoft
Windows 95 OSR2, 98 or higher, and Mac OS8.1.

Setting Up — General Information

* Find a suitable location near your computer to place the
scanner.

14
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CAUTION: Make sure the surface is flat. Operating your
scanner on an uneven surface can damage the internal
components.

e Turn your computer off. Unplug the computer’s power cable
from the electrical outlet.

Connecting the Hardware Interface Cables

If your computer has a USB port, follow the instructions in the
“Connecting the USB Cable” section to connect the scanner to your
computer.

If your computer has a parallel port, follow the instructions in the
“Connecting the Parallel Cable” section to connect the scanner to
your computer.

Connecting the USB Cable

The instructions for connecting the hardware interface cable are
different for PC and Macintosh users. Refer to the section below
that applies to your computer type.

PC Connection

1. Turn off your computer and unplug the power cord.

2. Locate the USB cable that is provided. Plug one end of this
cable firmly into the USB port on the back of the computer.

USB Connector Port

USB Connector Port

15



3. Plug the other end of this cable into the port located on the back
panel of the scanner.

Macintosh Connection

1. Turn off your computer and unplug the power cord.

2. Locate the USB cable that is provided. Plug one end of it firmly
into one of the USB ports. iMac computer ports are located on
the right side of the computer, or at either side of the keyboard.
The USB port on other Macintosh computers is located on the
back panel of the computer, or on a USB interface card.

3. Plug the other end of this cable into the port located on the back
panel of the scanner.

Connecting the Parallel Port Cable

1. Turn off your computer and unplug the power cord.

2. Locate the parallel cable included with your scanner. Connect
the 25-pin parallel interface cable to your PC’s parallel port.

16
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NOTE: If you have a printer connected to your computer’s
parallel port, disconnect the printer and plug it into the “To
Printer” port located on the back of the scanner. Plug the
scanner cable into the parallel port. This provides a pass-
through connection so you can use the printer of the scanner.

Plug the other end of this cable into the port located on the back
panel of the scanner.

Connecting the Power Adapter

1.

2.

Plug the scanner’s power adapter into an electrical outlet.

Insert the other end of this cable into the power adapter
receptacle on the rear panel of the scanner. The power indicator
on the front panel of the scanner should now be illuminated.

Plug your computer’s power cable into an electrical outlet.

Turn your computer on.

17



Installing the Software

Now that you have made the physical connection between the Astra
2000U/P scanner and your computer, the next step is to install the
software that allows the two devices to communicate with one
another.

Because the Macintosh and PC installation procedures are different
for PhotoDeluxe, the installation instructions for that software is
divided into PC and Macintosh software installation sections.

Installing PhotoDeluxe on Your PC

NOTE: PhotoDeluxe is compatible with Windows 98, 95 and
higher. Use the following steps to install your scanning software
rather than using the add/remove programs to install the software.

1. Insert the CD-ROM labeled “PhotoDeluxe” into your
computer’s CD-ROM drive. Your computer should
automatically read the disc and display a series of screens
regarding product licensing. Follow the onscreen instructions.

NOTE: If your computer does not automatically read the CD-
ROM after insertion, click on the “Start bar” and select
“Run...” A dialog box appears. Type “d:\autoplay.exe” in the
open text box. If your CD-ROM is designated with another
letter, substitute the appropriate letter for the drive.

2. A Licensing Agreement window appears. Enter the country
where you are currently located in and click Next.

3. Read the licensing agreement and then click Agree.

4. A PhotoDeluxe Install window appears. Click the Install
button. Follow the onscreen instructions.

5. When you get to the Setup Type window, choose Typical.

18
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11.
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Fill in the user information.

Click Next in the Start Copying Files window to begin
installing PhotoDeluxe Home Edition 3.0, Adobe Acrobat
Reader 3.01, Adobe ATM 4.0 and Microsoft Internet Explorer
4.01. Follow the onscreen instructions.

After Adobe Acrobat Reader 3.01 has been installed, a ReadMe
file appears. When you have read the ReadMe, select Exit from
the File menu.

The Adobe Type Manager window appears. Click the Install
button. Follow the onscreen instructions.

When the Adobe Product Registration window appears, enter
the relevant information and continue following the onscreen
instructions.

When a screen appears asking if you want to restart your
computer to finish the installation procedure, select Yes and
click the OK button.

NOTE: To access these files you must click on the “Start” bar,
select “Programs,” and then select “Adobe.” A cascading file
appears with “Read Me” information and other selections to choose
from. For information about setting up desktop shortcuts, refer to
your Microsoft Windows documentation.

Installing PhotoDeluxe on Your Macintosh

1.

Insert the CD-ROM labeled “PhotoDeluxe” into your
computer’s CD-ROM drive. Your computer should
automatically read the disc and display the folders contained on
the CD-ROM.

Double-click on the Adobe PhotoDeluxe Installer icon. Follow
the onscreen instructions.

19



An Adobe ReadMe file appears. After reading the text, click
Continue.

A PhotoDeluxe Installer window appears. Click the Install
button. Follow the onscreen instructions.

Complete the product registration form and click Next. Click
the Install Now button. After installation is complete, restart
your computer by clicking the Restart button. After the system
restarts, re-insert the PhotoDeluxe CD-ROM.

Double-click on the ATM application folder inside the
PhotoDeluxe CD-ROM window. Double-click on the Font and
Utilities folder, then Double-click on the Installer icon. Click
the Install icon to install the ATM files. Restart your system
after the installation is complete.

Install VistaScan Drivers, Presto! PageManager,
Presto! PhotoAlbum, Presto! PageType,
OmniPage LE and Online Manuals

1.

20

Insert the UMAX Scanner CD into your computer’s CD-ROM
after you have finished installing the software on the
PhotoDeluxe CD.

FOR PC USERS: If your computer does not automatically
begin installing the programs contained on this disc after
inserting it into the CD-ROM, click on the “Start bar,” select
“Run...” A dialog box appears. Type “d:/setup” in the dialog
box. If your CD-ROM is designated with another letter,
substitute the appropriate letter for the drive.

Follow the onscreen instructions to complete the installation of
Presto! PageManager, UMAX VistaScan, OmniPage LE,
MagicMatch Profile Pack and the online User’s Guide.

Restart your computer as suggested by the onscreen
instructions to complete the installation.
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CHAPTER 2. Your First Scan

Before you begin your first scan, you must install the scanner and
the bundled software. Refer to the Quick Start Guide for installation
and scanner test instructions.

You can perform a basic scan using any of the software
applications bundled with this scanner. For your first scan, we
suggest using the PhotoDeluxe software.

PCs and Macintosh have two different versions of the PhotoDeluxe

software, so we have included two separate sets of instructions.
Please follow the proper set of instructions for your system.

Opening the PhotoDeluxe Software

Open the PhotoDeluxe software application.

For PC Users:

1. Click the Start bar in the bottom-left corner of the screen.
2. Click Programs.

3. Select Adobe.

4. Select PhotoDeluxe Home Edition 3.0.

5. Click Adobe PhotoDeluxe Home Edition 3.0.

6. The PhotoDeluxe screen appears. Click the Get & Fix Photo
tab. A row of icons appears.

7. Click the Get Photo icon. A drop-down list appears. Click the

Scanners... option. A tabbed bar appears at the top of the
screen. Click the Scanner tab.

21



10.

11.
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NOTE: You only need to select the device driver once in
PhotoDeluxe and your selection will be saved.

Click the Choose Scanner icon. Click on the VistaScan, and
click OK. Click the Mode tab. Click the Custom icon. The
VistaScan window opens. VistaScan software controls the
various functions of the scanner and provides a communication
path between the scanner and the PhotoDeluxe software.

NOTE: Before using your scanner for the first time, use the
Scanner Test utility to verify that the scanner is able to
communicate with the computer. A test window appears the
first time you launch the VistaScan software after installing the
scanner.

Click the Scanner Test, and the UMAX Scanner Test Program
window opens. Click the Test button to test the scanner.

If the scanner passes, “Scanner Link Successful,” appears in the
status box. Click OK. If the scanner test fails, check your
connections and try the test again.

Click the Custom icon.
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Scanning an Image From the PC

1.

Select an item you would like to scan (a picture, a drawing,
etc.).

Lift the document cover and place the item facedown so it
aligns with the arrow ([) at the back edge of the object glass.

Click the Preview button on the right side of the VistaScan
Beginner window. The scanner begins a low-resolution scan of
the item.

When the preview scan is complete the preview image is
displayed in the Preview window (on the left side of the
VistaScan window).

You can change the view of the Preview image using the
“Zoom Tool,” or select a scanning region using the “Frame
Selection Tool.” To find out more about how to use these tools,
click on the user tips text that appears when your cursor pauses
over the tool.

NOTE: You must have a browser installed in order to view the
VistaScan online help.

In the Click to Scan section of the VistaScan Beginner

window, click the icon that corresponds to the type of image
you are scanning.

23



For example, if you are scanning a color photograph, choose
“Color Photo.” To scan text or a black and white drawing,
choose “Text/Lineart”. The image is scanned and you are
returned to the PhotoDeluxe window.

NOTE: Choosing an icon in the “Click to Scan” area does two
things: it activates the scanner, and automatically sets the
scanner settings. This ensures you get the best scanning results
for the item you are scanning.

A pop-up message appears on the right side of the screen
indicating that you should click the Done tab.

Click the Done tab. A Save as window opens. Enter a file name
for the scanned image. Indicate which folder or directory you
want to save the image file to, and specify in what file format
you want to save the image.

NOTE: If you do not assign a file name, the computer
automatically assigns a name that consists of the date, and a
two-digit reference number.

Enter a graphic title for the image that will appear in the My
Photos window.

Click on the Save & Send icon. Choose save from the drop-
down menu. Click the Save button to save the image.

10. Close the VistaScan window by clicking Exit.

For Macintosh Users:

1.

2.

3.

24

Double-click the Hard Drive icon.
Double-click the Adobe PhotoDeluxe 2.0 folder.

Double-click the Adobe PhotoDeluxe application icon to
launch PhotoDeluxe. The PhotoDeluxe screen appears.



4.

5.

6.
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Click the Get Photo button.
Click the Get Photo tab.

Click the Scanner button to display a menu of available input
sources. Select UMAX VistaScan, then click OK. The
VistaScan Beginner window appears.

NOTE: You only need to select the device driver once in
PhotoDeluxe. It will remember your selection the next time you
use the application.

Scanning an Image From the Macintosh

1.

4.

Select an item you would like to scan (a picture, a brochure,
etc.).

Lift the document cover and place the item facedown so it
aligns with the arrow ([) at the back edge of the object glass.

Click the Preview button on the right side of the VistaScan
Beginner window and the scanner begins a low-resolution scan.

When the preview scan is complete the preview image is

displayed in the Preview window (on the left side of the
VistaScan window).

25
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You can change the view size of the Preview image before
scanning the final image using the “Zoom Tool,” or select a
region to scan using the “Frame Selection Tool.” To find out
more about how to use these tools, click on the user tips text
that appears when your cursor pauses over the tool.

NOTE: You must have a browser installed in order to view the
VistaScan online help.

In the Click to Scan section of the VistaScan Beginner
window, click the icon that corresponds to the type of image
you are scanning.

For example, if you are scanning a color photograph, choose
“Color Photo.” To scan text or a black and white drawing,
choose “Text/Lineart”. The image is scanned and you are
returned to the PhotoDeluxe window.

When the scan is complete, a window appears requesting that
you save the document. Type a name in the field that appears to
the right of “Save this document as:”

NOTE: By default the image is saved as “untitled - #” in the
Acquire section of the floating gallery window. You can also
choose to save the image in the hard drive or on the desktop by
clicking on the arrow to the right of the My Photos box at the
top of this window.

After a moment the image appears in the My Photos gallery
window. Double-click the thumbnail to view a full-size, high-
resolution scan of the image in the work area.

Exit PhotoDeluxe by selecting Quit from the File menu.
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Turning the Scanner Lamp On and Off

For PC Users Only: You can turn the scanner lamp on and off
using the Astra 2000’s built-in Power Saving utility. The lamp
remains on whenever the scanner has power, unless you turn it off
using the UMAX Power Saving utility. Turning off the scanner
lamp when you are not scanning prolongs the life of the lamp.

The Power Saving utility window appears whenever you close
VistaScan.

lamp FH|

UMAX

_—

Lamp !Muﬂ' |

It appears in the bottom-right corner of your desktop by default.
The window displays an image of the scanner with the lamp
illuminated.

To turn the scanner lamp off:

Click on the image of the scanner in the Power Saving utility
window. After a second or two, the light in the scanner image goes
out, and your scanner lamp is turned off.

To turn the scanner lamp on:

Open the VistaScan software, or simply click on the scanner image
in the Power Saving utility window.

NOTE: The scanner lamp is different from the Power Indicator
light. The Power Indicator light is the very small, green light
located directly above the UMAX logo on the front panel of the
scanner. This indicator remains ON whenever the scanner is
plugged into an electrical outlet (regardless of whether the Power
Saving utility is engaged).

27
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CHAPTER 3. Scanning Basics

VistaScan is the primary program or "driver" that you will use to
scan with your Astra 2000 scanner. It is a "TWAIN-compliant"
program, which means that it can be run from other programs that
support scanning, like PhotoDeluxe, OmniPage, and others. It is
also a "stand-alone" program, which allows you to scan images for
a variety of uses, even without launching another program first.

Setting VistaScan Preferences

Preferences control scanner settings that you generally do not
modify every time you use the scanner. The Preference settings are
used as the default settings for several of the scan settings.

To access the VistaScan Preferences, click the Preferences icon in
the upper right corner of the VistaScan window.

The Preferences cover three areas:

e General
e Scan Destination
e Scanner Information

A tab at the top of the Preferences window indicates each
VistaScan preference group. To view the Preference settings for an
area, click on the associated tab.

General

The General tab contains preference settings that control color
matching and color correction, and whether to display the ruler and
tips.

29
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Color Matching/Correction

Color Matching allows you to fine-tune the colors of scanned
images so that they emulate the colors of your original source
documents as closely as possible. This is accomplished using
MagicMatch.

When you click on the MagicMatch checkbox (so a checkmark
appears) the Profile List displays. A profile is a list of applicable
calibration profiles, which MagicMatch uses to render a final output
image. If a printer or calibration profile is not chosen, MagicMatch
will calibrate the image to optimize its display on a monitor.

MagicMatch only functions when you are scanning in color mode.
When you are using Magic Match you need to disable the
Level/Curve and Color Adjustment/Balance settings in the
VistaScan Advanced window.

30
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Show Ruler

The Show Ruler command displays or hides the rulers that border
the top and left sides of the Preview window. These rulers
correspond to the rulers on your scanner's object glass. Clicking on
the Show Ruler checkbox turns off (removes the checkmark) and
hides the ruler. Clicking on the checkbox again turns the feature on
(displays a checkmark) and shows the ruler.

Tips Help

The Tips Help option determines whether tips are displayed when
you pause with your cursor over a VistaScan option. Click on the
Tips Help box to enable tips (displays a checkmark). When a
checkmark appears, clicking the checkbox disables the tips and
removes the checkmark.

Scan Destination

The options in this Preferences tab specify how scanned images are
stored, printed, faxed, transferred to another application, or
transmitted via e-mail.
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File
To set the location for your stored images:

1. Click on the File icon, the file preferences appear to the right of

the Scan To icon set.

2. Enter the directory in which you want to store the scanned
image file, in the File Directory text box. If you are not sure of
the directory path, click the Browse button to locate the desired
directory.

3. Enter the file name under which you want to store the scanned
image files (such as TMP) in the File Name text box.

4. Select the file format in which you want to save scanned
images from the File Format drop down list.

Printer
To specify which printer to use when printing scanned images:

1. Click on the Printer icon, the printer currently selected as the
default appears to the right of the Scan To icon set.

=

2. If you want to change any of the printer settings, click on the
Properties button. The standard Print Setup dialog box opens.
Make any changes you want, and then click OK to return to the
Preference settings.
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E-mail

To specify which e-mail application to use when you e-mail
scanned images:

1. Click on the E-mail icon, the e-mail preferences appear to the
right of the Scan To icon set.

2. Click on the button next to the e-mail software you are using
(Microsoft Exchange or Lotus cc:Mail).

3. Select the image format you want to use when you attach
scanned images to your email application from the Image
Format drop down list.

Fax

1. Click on the Fax icon, the fax driver (or printer driver if a fax
driver is not selected) currently selected as the default appears
to the right of the Scan To icon set.

2. If you want to change any of the settings, click on the
Properties button. The standard Print Setup dialog box opens.
Make any changes you want, and then click OK to return to the
Preference settings.
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Application

1. Click on the Application icon, the application preferences
appear to the right of the Scan To icon set.

2. Enter the application name to which you want to send the
scanned image files (such as Presto! PageManager) in the
Application Name text box.

3. Enter the file name of the application executable in the File
Name text box. If you are not sure of the directory path, click
the Browse button to locate the correct path.

4. Select the image format in which you want to save scanned
images from the Image Format drop down list.
Scanner Information

The Scanner Information tab displays important information about
your scanner.
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The information includes:

» Scanner Manufacturer

» Scanner Model

*  Firmware Version

» VistaScan Version

* Maximum Scan Width and Length
*  Maximum Resolution

VistaScan Beginner Window Features

The VistaScan Beginner window appears when you open
VistaScan.

1.
X
E
A

The Beginner window features allow you to scan a wide variety of
documents, photos, and graphics by clicking just a few buttons.
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Scanning an item using the Beginner window options consists of
just a few steps:

1.

Perform a preview scan of the item to be scanned by clicking
on the Preview button. The item is quickly scanned at low-
resolution, and is displayed in the Preview window (on the left
side of the VistaScan Beginner window).

Select what you want to do with the image after it is scanned
using the Scan To icons.

Specify what kind of image you are going to scan, and start the
final scan process using the Click To Scan icons.

Performing the Preview Scan

The Preview feature lets you scan an item at low-resolution so you
can define the specific area to be scanned when you scan at higher
resolution.

To preview the item you are going to scan:

1.

36

Place the item you want to scan facedown on the object glass,
under the inverted triangle that appears in the center of the rear
ruler.

Click the Preview button on the right side of the Beginner
window.

The image is quickly scanned and displayed in the Preview
window.
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There are three Preview tools in the VistaScan Beginner window.

Zoom Tool

Frame Tool

Move Tool

Zoom tool — Lets you enlarge or reduce the view of the image in
the Preview window. To use the Zoom tool:

Once the preview image appears in the Preview window, click on
the Magnifying Glass icon.

Move your cursor into the Preview window and click. The image
enlarges. To reduce the view size, press the shift key and click in
the Preview window.

Frame tool — Lets you select the portion of the image displayed in
the Preview window you want scanned in the final scan step.

You can size the selection frame by clicking on the Frame tool and
placing your cursor over one of the four edges of the frame (which
changes the cursor shape to a two-headed arrow), drag the Frame
inward to reduce the size, or outward to increase the size.

You can also move a selected frame by positioning the cursor
inside the frame (which changes the cursor shape to a four-direction
arrow), and dragging the frame to another location in the Preview
window.
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Move tool — Lets you move an image in the Preview window so
you can see portions that are not visible because the image is too
large to display completely. Click on the Move tool. Put the cursor
inside the Preview window (which changes the cursor shape to a
hand). Scroll the image view by clicking and dragging the cursor.

Selecting the Scan to Device or Application

To specify which device or application to which you want to send
the scanned item:

1. Click on the icon that represents the device or application to
which you want to send the scanned item.

The icons include:

File — stores the scanned image in a file using the file name
specified in the VistaScan Preferences.

Print — prints the scanned item on the default printer.
Fax — faxes the scanned item using your fax driver.

Application — sends the scanned item to the applications
specified in the VistaScan Preferences.

E-mail — sends the scanned item as a graphic file to your
Microsoft Exchange or Lotus cc:Mail e-mail application.
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Defining the Type of Image your are Going to Scan

The Beginner window provides you with pre-defined scanning
options so you can quickly and easily scan any of the following
items:

» Color Photos — use this setting when you want to scan color or
black and white photos

»  Printed Matter — use this setting when you want to scan
something that has been printed like a brochure, magazine, etc.

e Text/Lineart documents — use this setting when you want to
scan the text contained in a document, or when you want to
scan simple lineart graphics

» Web Images — use this setting when you want to scan graphics
and then use them on the web

To specify the type of image you going to scan, click on the icon
that represents the type of item you want to scan.

Text/Lineart
Settings icon

Printed Matter
Settings icon

Text/Lineart

: 3 Web Image
Settings icon

Settings icon

Clicking on any of these icons automatically starts the final scan
process using the pre-defined scan settings. The scanned image is
saved, or is sent to the device or application you specified by
clicking on the Scan To icon.
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VistaScan Advanced Features

The VistaScan Advanced window gives you the ability to adjust the
scan setting individually so you can customize the settings for the
type of document you are going to scan. If you are a novice
computer user, you may want to use the VistaScan Beginner
window until you are more familiar with VistaScan and the
scanning process. The Beginner window options are preset to
provide a quick and easy way to scan images.

If you are an experienced computer user with some scanning
experience, you can use the features contained in the Advanced
window to optimize the scan process for the specific item you are
going to scan.

The Advanced window contains the following tools and features
you can use to scan documents:

e Original Document Source Settings
* Image Mode Settings

* Resolution Settings

» Descreen Settings

»  Filter Settings

e Scaling Options

e Auto Adjustment Setting

» Scan Control Unit

e Multiple Scan Mode Settings

» Color Adjustment Feature Panel

Changing the Original Document Source

The Original Document Source setting identifies the item you want
to scan.
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You can choose from the following settings:

Flatbed Reflective: Scans paper originals (non-transparencies) e.g.,
photographs, documents, and brochures.

Three other setting options appear onscreen that are not available
with this scanner: UTA Transmissive, UTA Negative, Automatic
Document Feeder.

Changing the Image Mode

VistaScan can scan a wide variety of image types.

5[ True Color, RGB o
.  True Color. RGE

e Color ChiYE

256 Colors

wieb Colars

BAM Phato
B2 Docurrient
Fid

Tiue Colar, 35-Bit AGE
B Phatao, 12-Bit

True Color, RGB: Scans a full color photo or document. The RGB
indicates the colors of Red, Green and Blue. This setting creates
larger files than the B/W Photo setting.
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True Color, CMYK: Converts RGB (video) color data into
CMYK (printed) color data using a special color transformation
process. When scanning is completed the CMYK image is ready for
printing on a CMYK color printer.

NOTE: Most ink jet printers use RGB rather than CMYK printing.

256 Colors: Scans color images using 256 colors. The 256 color
images take up less memory and hard disk space than the True
Color RGB option.

Web Photo: Scans an image at the appropriate resolution for
display on the monitor.

B/W Photo: Scans black and white photos using 256 shades of
gray (ranging from white to black) so you get smooth shade
transitions in your scanned image.

B/W Document: Scans text documents, black and white line art,
and other black and white documents. This selection creates the
smallest files.

FAX: Scans at the appropriate resolution for faxing.

OCR: Scans at the appropriate settings for optimal OCR
recognition.

True Color 36-bit RGB: Scans a full color photo or document
using 36-bits of information to define each pixel. The RGB
indicates the colors of Red, Green and Blue. This setting creates
larger files than the True Color RGB setting.

NOTE: Not all graphic applications support 36-bit graphic files.
To determine whether the software you want to use is capable of
working with 36-bit graphics, refer to your software documentation.

B/W Photo, 12-bit: Scans a black and white photo using 12-bits of
data to define each pixel. This setting produces more gray shade
accuracy than the B/W Photo option, but also produces larger file
sizes.
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Changing the Resolution Setting

Scanning resolution is measured in dots per inch (DPI). Resolution
determines the amount of information the scanner will capture in a

scanned image. The higher the resolution, the finer the image detail,
and the larger the file sizes.

VistaScan lets you choose from the following resolution settings:
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Higher — this option opens a drop down menu that contains
higher resolution settings which include 9600, 8400, 7200,
6000, 4800, 3600, 2400, 1800, and 1600 dpi selections.
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The table below gives you an idea of the file sizes you can expect
based on the original image size and the resolution setting you
specify. These values are based on scanning images in 24-bit, True

Color RGB mode. Image sizes shown below are given in

MegaBytes.

Table 1. Resolution/File-Size Guidelines

Resolution Image Size: | Image Size: | Image Size:
(dots per inch) | 4x5 5x7 8.5x11

72 0.30 0.53 1.39

100 0.58 1.00 2.68

200 2.29 4.01 10.70

300 5.15 9.01 24.10

400 9.16 16.00 42.80

600 20.60 36.10 96.30

800 36.60 64.10 171.20
1200 82.40 144.20 385.20

NOTE: Choosing the True Color RGB 36-bit setting captures more
data than the 24-bit setting. This means that the file sizes listed
above will be larger if you scanned images using the True Color 36-
bit RGB setting.

Choosing the Best Resolution for Your Scanning Project

To choose the best resolution for scanning, determine what you are
going to do with the image once it is scanned. Matching your
scanning resolution to the image use will give you the best image
for that purpose and will keep the file sizes to the minimum needed.

Table 2. Recommended Resolutions

Image Use Recommended Resolution
Printing 300 — 600*

Viewing on the Screen 72

Viewing on the Web 72

OCR, B/W 300

Pre-Press 600

Enlarging or reducing 600

* Depending on the resolution of your printer
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Using Custom Resolution Settings

You can also specify custom resolution settings that you can use
when you scan. The maximum custom resolution setting you can
define is 2400 dpi. To define the custom resolution settings:

1. Choose the Custom... option from the Resolution drop down
menu. The Custom Resolution window opens.

Custom Flesalution
Max rschbion 2400 doi
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2. Enter the desired resolution setting (between 50 and 2400 dpi)
in the Custom resolution #1 text box.

3. Repeat step 2 to define the Custom resolution #2 and Custom
resolution #3 settings.

4. Click OK. The settings you defined appear on the Resolution
setting drop down menu, under the Custom heading.
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Changing the Descreen Feature

The Descreen option helps eliminate the patterns that can appear
when you scan printed images found in magazines, brochures,
catalogues, etc. (half-tone images). This is accomplished by
changing the number of lines that appear in every inch (lines per
inch) of the scanned image.

The Descreen feature is unavailable when you have chosen the B/W
Document, Fax or OCR resolution settings.

To change the Descreen setting:

1. Click the Descreen option to display the drop down menu.
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2. Choose one of the descreen options:
No Descreen — No Descreening.

Magazine — Specifies 133 lines per inch. This option
smoothes the fine dot pattern found in glossy magazines.

Newspaper — Specifies 85 lines per inch. Smoothes the coarse
grain pattern commonly found in newspaper images.
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Art print — Specifies 175 lines per inch. Smoothes the fine
dot pattern found in high quality art prints.

Custom — Opens the Custom Descreen window, which allows
you to specify a custom line screen value. Refer to the Using
Custom Descreen Settings section that follows for information
about how to set custom descreen values.

Using Custom Descreen Settings

You can also specify custom descreen settings that you can use
when you want to change the lines per inch setting to eliminate
patterns that are generated while scanning printed images. You can
enter custom settings that range from 35 to 400 lines per inch. To
define the custom descreen settings:

1. Choose the Custom... option from the Descreen drop down
menu. The Custom Descreen window opens.

2. Enter the desired lines per inch setting (between 35 and 400 Ipi)
in the Custom descreen Ipi #1 text box.

3. Repeat step 2 to define the Custom descreen #2 and Custom
descreen #3 settings.

4. Click OK. The settings you defined appear on the Descreen
setting drop down menu, under the Custom heading.
Changing the Filter Setting

Image filters are used to soften or sharpen edges and boundaries of
an image.

[\ No Filter 2

a ' Mo Filter
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VistaScan provides the following filter options:

No Filter — Use this option when you do not want to sharpen or
blur the image.

Sharpen — Use this option to sharpen lines that may be fuzzy or not
clean in the original image.

Sharpen More — Use this option when you want to sharpen the
image more than the standard Sharpen filter does.

Blur — Use this option when you want to soften the edges of an
image.

Blur More — Use this option when you want to soften the edges
more than the Blur filter does.

Changing the Scale Factor

Scaling lets you automatically enlarge or reduce an image from its
original size (100%) as it is scanned. The scale factor affects the
size of the scanned image and the printed scan output.
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You can scale the image using any of the scale factors listed below:

e 200%

« 150%
 100%

e 50%

e 25%

e 10%

e Custom

You can also specify a custom scale factor by choosing the Custom
option from the Scaling drop down menu. See the Using Custom
Scaling Settings section that follows for more information about
specifying a custom scale factor.

Using Custom Scale Settings

You can specify custom scaling settings that you can use when you
scan. To define the custom scaling settings:

1. Choose the Custom... option from the Scaling drop down
menu. The Custom Scaling window opens.
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2. Enter the desired scale factor in either the Width or Height text
box. These are dynamic fields, updating one field automatically
changes the other field.

3. To change the unit of measure, click on the down arrow next to
Height and/or Width text boxes to display the possible settings.
You can choose from Inch, Centimeter, Pixel or Percent.

4. Click OK.

Using the Auto Adjustment Feature

Auto Adjustment provides a simple way to adjust the light and dark
values of a color or grayscale image you want to scan.

To automatically adjust the light and dark values:
1. Place the item you want to scan on the scanner object glass.

2. Click the Preview button from the VistaScan Advanced
window.

3. Select an area that you want to adjust using the Frame tool.

You can edit the Preview image before scanning the final
image using the “Zoom Tool” and the “Frame Selection Tool.”
To find out more about how to use these tools, click on the user
tips text that appears when your cursor pauses over the tool.

NOTE: To use VistaScan online help you must have a browser
installed on the system.

4. Click the Auto Adjustment check box. The selected area is

adjusted and the preview image repaints displaying the results
you can expect when you perform the final scan.
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Using the Scan Control Unit

The Scan Control unit contains the Preview and Scan buttons, and
the Scan To options.

Preview

Selecting the Scan to Device or Application

To specify the device or application to which you want to send the
scanned item:

1. Click on the arrow above the Scan To text on the Scan Control
unit. The Scan Control unit panel slides back to display the
Scan To icons.

2. Click on the icon that represents the device or application to
which you want to send the scanned item. The icons include:

File — stores the scanned image in a file using the file name
specified in the VistaScan Preferences.

Print — prints the scanned item on the default printer.

Fax — faxes the scanned item using your fax driver.
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Application — sends the scanned item to the applications
specified in the VistaScan Preferences.

E-mail — sends the scanned item as a graphic file to your
Microsoft Exchange or Lotus cc:Mail e-mail application.
Using the Multiple Scan Mode

You can select multiple portions of the image you scanned in
Preview mode using the Multiple Frame tool.

P

The Multiple Frame tool allows you to create two or more selection
frames in the Preview Window.

To create more than one selection frame:

1. After you have scanned an image in Preview scan mode, click
on the Multiple Frame tool.

2. Select the area you want contained in the first frame by clicking
on the point at which you want to begin the frame, and then
dragging the tool diagonally until the area of interest is
contained in the marquis box.

3. Click outside of a selected area to save the frame. To create
other frames, repeat steps 1 and 2 until you have created all the
desired frames. After you create a frame, the Single Frame tool
is automatically selected so you can resize or move the frame
you just created.
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To select one of the frames you created, double-click on the desired
frame. The frame border of the active frame changes to a marquis
style frame (dotted lines). Once a frame is selected, double-click on
a frame to display the Job Information window for that image,
which contains the image information.

To remove a selected frame:

1. Click on the Job List button. Thumbnails of the selected
frames appear in the job list window.
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2. Click on the thumbnail of the frame you want to remove. A red
box appears around the selected thumbnail. The frame in the
Preview window associated with the thumbnail, changes to a
dashed outline.

3. Click on the “X” button, located in the bottom-left corner of the
thumbnail, to remove the frame.

Using the Color Adjustment Features

The Color Adjustment features allow you to make adjustments to
the colors and/or tones in an image. The following lists the color
adjustment settings you can modify:

* Brightness, contrast, highlights, shadows, and gamma curve
* Image tones

» Color balance

* Rotation
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Adjusting Image Brightness, Contrast, Highlights and Shadows

When you click on the Brightness/Contrast tab from the Color
Adjustment panel a series of slide bars appear. You adjust the
associated tones by dragging the slider in one of the bars to the left
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Using the Brightness Bar

This setting determines the overall intensity level (gray level) of an
image. Moving the slider on the scroll bar to the right increases the
brightness. Moving it to the left decreases the brightness. The
default setting is zero 0. The maximum brightness setting is 100,
the minimum setting is —100.

Using the Contrast Bar

This setting controls the difference between light and dark areas in
an image. Moving the slider on the scroll bar to the right increases
the gray shades between light and dark areas. Moving it to the left
decreases gray shades between light and dark areas. The default
setting is zero 0. The maximum contrast setting is 100, the
minimum setting is —100.
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Highlight Bar

This setting defines the lightest (whitest) tones in the scanned
image. If you broaden the range that includes the highlight points,
the pixels within the newly specified range are be remapped
allowing you to see more details in a color/gray image.

Moving the slider on the scroll bar to the left increases the
brightness. Moving it to the right decreases the brightness. The
default setting is 255. The maximum highlight setting is 255; the
minimum is 1 (which is White).

Shadow Bar

The Shadow bar defines the darkest tones in the scanned image.
Moving the slider on the scroll bar to the left increases the
brightness in shadowed areas. Moving it to the right decreases the
brightness in shadowed areas. The default setting is 0. The
maximum shadow setting is 254 (which is Black), the minimum is
0.

Gamma Bar

The gamma bar alters the mid-range gray tones in the scanned
image. All optical devices, such as monitors and scanners, have
some variance in their light sensitivity characteristics. To get a
scanned image with good results, VistaScan provides Gamma
adjustment capabilities so you can compensate for this variance in
your scanner.

Moving the slider on the scroll bar to the right increases the
brightness of the mid-range gray tones. Moving it to the left
decreases the brightness of the mid-range gray tones. The default
setting is 1.2.

Reset Button

Click the Reset button to cancel the changes and return the value to
the default setting.
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Adjusting the Image Tones

The Curve command is another way to make precise adjustments in
the highlight, midtones, or shadow levels in your images. Using
this feature corrects the gray/color values in an image. You change
the values by altering the shape of the curve that represents the
brightness values of pixels.

Click Reset to cancel the changes and return the value to the default
setting.

Adjusting the Color Balance

The Color Adjustment feature controls the hue and saturation of a
particular color.

When you click on the Color Balance tab from the Color
Adjustments panel a continuous color spectrum wheel appears.
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When you click in the wheel the image tones are shifted to the
particular hue that is represented in that area.

Click the Reset button to cancel the changes and returns the value
to default setting.
Rotating an Image

You can rotate an image clockwise or counter clockwise, and you
can flip images 180 degrees vertically or horizontally.
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The following lists the possible rotate and flip selections:

» Flip/Rotate Horizontally — flips the image horizontally and
rotates it 90 degrees counter clockwise.

*  Flip Horizontal - flips the image horizontally.

* Rotate 90 CCW - rotates the image 90 degrees counter
clockwise.

* Rotate 90 CW - rotates the image 90 degrees clockwise.

* Normal — does not rotate or flip the image.

» Flip Vertical —flips the image vertically.

* Rotate 180 — rotates the image 180 degrees clockwise.

* Inverts an image — changes all the dark tones in an image to
light tones, and all of the light tones to dark tones. This option
can NOT be reversed using the Edit menu Undo command.

Clicking on the image that shows the desired orientation rotates or
flips the image. Clicking the Reset button cancels the rotate or flip
action and returns the image to the original orientation.

Using VistaAccess — Direct Access

VistaAccess is a utility that provides instant access to several
VistaScan applications. When VistaAccess is open, it allows you to
open any of the listed applications with a few clicks of your mouse.

To use VistaAccess from the PC;:

1. Click on the Start bar. Click on the Programs option. When
the Programs pop-up menu appears, click the VistaScan
option. The VistaScan pop-up menu appears. Click the
VistaAccess option to display the scanner icon in the Windows
Task bar (near the time display in the lower right corner of the
window).

2. Click the scanner icon in the Task bar using your right mouse
button. A pop-up menu appears which contains:

« VistaScan
* VistaShuttle
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»  Copy Utility

e Scanner Test

»  Power Saving On/Off Control
» Find/Refresh Scanner

e Help

e Exit

Click on one of the listed applications or utilities to launch the
software.

Click the Find/Refresh Scanner option to re-initialize the
scanner. Click the Help option to view VistaAccess online
help. Click the Exit option to remove the scanner icon from the
Windows Task bar and close VistaAccess.

To use VistaAccess from the Macintosh:

1.
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Click on the control strip in the lower left corner of the
Desktop. A drop down menu appears which contains:

* VistaScan
* Power Saving On/Off Control
¢ Find/Refresh Scanner

Click on one of the listed applications or utilities to launch the
software.

Click the Find/Refresh Scanner option to re-initialize the
scanner. Click the Help option to view VistaAccess online
help. Click the Exit option to remove the scanner icon from the
Finder area and close VistaAccess.
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Using VistaShuttle

The VistaShuttle is a PC-based application that provides an easy
way for you to create greeting cards, wallpaper for your computer
desktop, a screen saver for your computer, e-cards (e-mail greeting
cards), and more.

NOTE: VistaShuttle is not a Macintosh compatible application.

To use VistaShuttle to create an E-Card (electronic greeting card
you send via e-mail):

1. Click on the Start bar. Click on the Programs option. When
the Programs pop-up menu appears, click on the VistaShuttle
option. Click on the VistaShuttle application icon to open the
program. The VistaShuttle Main window appears.

Wallpaper Scroonm Saveor

2. Click on the E-Card icon. The VistaScan Beginner window
opens so you can scan an item to include in your electronic
greeting card.

3. Lift the scanner’s document cover and place your document
facedown in the center of the scanner’s object glass.
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4. Click Preview to preview the scanned item. You can edit the
Preview image before scanning the final image using the
“Zoom Tool” and the “Frame Selection Tool.” To find out
more about how to use these tools, click on the user tips text
that appears when your cursor pauses over the tool.

NOTE: You must have a browser installed in order to view the
VistaScan online help.

5. Click the icon that most closely represents the item you are
going to scan in the Click To Scan area of the VistaScan
Beginner window.

The item is scanned, and VistaScan automatically closes. After
a moment the VistaShuttle E-Card window appears with the
scanned item in the default E-Card template.

6. Click on the scanned item to display the image handles. Drag
one of the image handles outward to enlarge the image, or
inward to reduce the image.

You can customize the E-Card template frame that surrounds
the scanned item, the stamp graphic or the paper type by
clicking the desired option from the buttons in the left column.

7. Click and drag any of the E-Card template elements to move
them around, creating your own E-Card style.
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Choose the Add text command from the Text menu (or click on
the Text button from the left-hand column). The Text Setting
window opens.

Enter the E-Card greeting text in the text box.

You can modify the font type, font size, font style (bold, italic,
underlined), text alignment (left, right or centered), and text
color by selecting an option from the dropdown lists or by
clicking on the associated icon from the button bar at the top of
the E-Card window.

Click the Finish button to place the text on the card..

g

Click the Close button in the upper right corner to close the
Text Setting window. You can move the text box around the E-
Card until you find the right spot. Click outside the text box to
anchor the text to the chosen spot.

Click the Mail button from the E-Card window. The Send
dialog box appears.

Choose your e-mail application from those listed, and click the
Send button to open the application and attach your E-Card to
the message.

Send your e-mail message.

Using the UMAX Copy Utility

The UMAX Copy utility is a PC-based application that lets you
scan and automatically print copies of an image.

NOTE: The UMAX Copy Utility is not Macintosh compatible.
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To use the copy utility:

1. Click on the Start bar. Click on the Programs option. When
the Programs pop-up menu appears, click on the VistaScan
option. The VistaScan pop-up menu appears. Click on the
UMAX Copy Utility selection to open the program.

2. The UMAX Copy Utility window appears.
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3. Select your copy settings. Click the copy button to make the
copies, then click Exit when you are finished.

UMAX Copy Utility Features

Brightness: Lets you select the brightness levels to use when you
print the copies of the scanned image. If the image is too dark,
click the up arrow to lighten the copy. If the image is too light,
click the down arrow to darken the copy.
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Original Image: Lets you specify the type of image to be copied
— Color, Gray or B/W. The Single Photo option automatically
crops unnecessary white space around the image (no matter where
the image is placed), reducing memory storage space and speeding
up the scanning.

Printout Quality: Choose Normal for draft quality, or choose Best
for high quality images.

* B/W images — Selecting Best or Normal produces the same
output.

» Gray images — Selecting Best uses an enhanced filter to
improve image quality but slows down the print speed.

« Color image — Selecting Normal uses an enhanced filter
to improve color quality; selecting Best uses the
MagicMatch function to produce the best image quality.

Printer Setup — Opens the Printer Setup dialog box.

Reset — Returns any settings you have modified to the default
settings.

Exit — Returns you to the desktop window.

Numeric Buttons — Lets you specify the number of copies by
clicking on the desired number. The number appears to the left.

Scaling — Sets the printout size of your scanned image; the default
is 100%.

Copy/Stop — Copy your scanned image by clicking the Copy

button. When copying begins the button text changes to read Stop.
To stop printing copies, click the Stop button.
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CHAPTER 4. Scanning Projects

The UMAX Astra 2000 scanners include bundled software to help
you with a variety of tasks. In this chapter, we will show you how
to make a personalized calendar, create Web-ready images, and
even turn a page of text into an online text document that you can
edit.

Using VistaScan to Scan and
Print Images

To perform your first scan:
1. Open the VistaScan software application.
For PC Users:

a. Click on the Start bar in the bottom-left corner of the
screen.

b. Click Programs.
c. Select VistaScan.
d. Click VistaScan.
For Macintosh Users:
a. Double-click the Hard Drive icon.
b. Double-click the UMAX VistaScan folder.

c. Double-click the UMAX VistaScan application icon to
launch VistaScan.
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The VistaScan Beginner window appears. Lift the scanner’s
document cover and place your document facedown in the
center of the scanner’s object glass.

Click the Preview button to preview the scanned item. You can
edit the Preview image before scanning the final image using
the “Zoom Tool” and the “Frame Selection Tool.” To find out
more about how to use these tools, click on the user tips text
that appears when your cursor pauses over the tool.

NOTE: This feature is only available if you have a browser
installed.

Click the Printer icon in the “Scan to” control panel to indicate
that you want to scan and print the image.

Click one of the four icons in the Click to Scan area of the
VistaScan Beginner window. Your selection identifies the type
of image you are about to scan and tells VistaScan how to set
the scanner options for the best results. The image type
selections include: Color photos, Text/lineart, Web Images and
Printed Matter settings.

Once you click on the desired image type, the scanner starts
scanning the image using the appropriate settings.

For Macintosh Users:

After the scan is complete, a print window appears. Verify that
the destination settings are correct and then click the Print
button.

When the scan is complete, the image is printed on your printer.
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Using VistaScan to Scan a Photo
to E-mail

Scanning an image to e-mail is almost the same procedure as
described in the Using VistaScan to Scan and Print Images section
earlier in this guide. Follow steps 1 — 3 as listed in the Scan and
Print instructions, and then proceed with the following steps:

1. Click on the E-mail icon to set the scanner settings to the best
values for scanning an image to E-mail.

NOTE: You may need to adjust the destination preferences in
the VistaScan Beginner window. For information about setting
preferences, refer to Setting the VistaScan Preferences section
earlier in this guide.

2. Click on the Web Image icon in the Click to Scan area of the
VistaScan Beginner window. The scanner starts scanning the
image using the appropriate settings for web images.

3. When the scanner has completed scanning the image, a
Microsoft Exchange or Lotus cc:Mail e-mail window appears
with an icon representing the scanned image embedded in the
message area of the window.

NOTE: For more information about using Microsoft Exchange
or Lotus cc:Mail refer to the user documentation that came with
the application.

4. Fill out the rest of the standard E-mail information (address,
subject, etc.) as you ordinarily would. Send the E-mail.
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Using VistaScan with PhotoDeluxe to
Create Web-ready Images

Add flair to your Web pages by importing scanned photos.

The version of PhotoDeluxe is different for PC and Macintosh
users. Follow the appropriate set of instructions based on the type
of system you are using.

For PC Users:

1. Open the PhotoDeluxe application. For detailed instructions on
how to start PhotoDeluxe, refer to steps 1-5 from Chapter 2.
Your First Scan.

2. The PhotoDeluxe screen appears. Click on the Get & Fix Photo
tab in the upper-left corner, and then select the Get Photo

button.
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The Get Photo drop down menu appears.
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Click the Scanners... option. The VistaScan software opens
displaying the Beginner window.

Select an image you want to scan to be posted on a web site
(i.e., a picture, a postcard, etc.).

Lift the document cover and place the item you have selected
facedown in the center of the object glass of the scanner.

Click the Preview button. The scanner begins a low-resolution
scan of the image.

The preview image displays in the Preview window.

Click on the Web Image icon in the Click to Scan section of
the VistaScan window.

After the image is scanned, VistaScan automatically closes and
you are returned to the PhotoDeluxe window. The scanned
image appears in the PhotoDeluxe work area. Click the Done
tab.

A thumbnail of the image you just scanned appears in the Open
Photos window on the left side of the PhotoDeluxe window.

Click on the Save & Send icon.

Choose the To the World Wide Web... option from the drop-
down menu.

Follow the onscreen instructions for trimming, sizing, reducing,

and specifying the file format (either GIF or JPEG compressed
formats).
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If you choose the GIF format:

a. An Export Options window appears notifying you it
will convert the photo to the GIF format. Click OK.

b. An Export GIF window appears. Go to the next
numbered step.

If you choose the JPEG format:
a. A Save window appears. Go to the next numbered step.
14. Select the location where you want to save the image by
clicking on the arrow to the right of the Save in field. This
displays your folder or directory structure. Choose a location by

clicking on it.

15. Enter the name you would like to save the file as in the File
name field. Click the Save button.

16. Click the Done tab. Your Web-ready image is now located in
the destination you specified.

For Macintosh Users:

1. Open the PhotoDeluxe application. The PhotoDeluxe window
appears.

g r— = .
Photaleluxe

72



10.

UMAX Astra 2000U/P Owner’s Guide

Refer to Chapter 2. Your First Scan for instructions on how to
start PhotoDeluxe.

Place the item you would like to scan (a picture, a brochure,
etc.) facedown so it aligns with the arrow ([1) at the back edge
of the object glass.

Click the Preview button on the right side of the VistaScan
Beginner window. A window appears notifying you that the
scanner is calibrating.

The preview image should now be displayed in the Preview
window area on the left side of the VistaScan window.

You can edit the Preview image before scanning the final
image using the “Zoom Tool” and the “Frame Selection Tool.”

Click on the Web Image icon in the Click to Scan section of
the VistaScan Beginner window. The image is scanned and
then you are returned to the PhotoDeluxe window.

NOTE: Choosing an icon in “Click to Scan” area does two
things: it activates the scanner, and automatically sets all of the
scanner settings to ensure you get the best scanning results.

When the scan is complete, a window appears requesting that
you save the document. Type a name in the field that appears to
the right of “Save this document as:”

NOTE: By default the image is saved as “untitled - #” in the
Acquire section of the floating gallery window. You can also
choose to save the image in the hard drive or on the desktop by
clicking on the arrow to the right of the My Photos box at the
top of this window.

After a moment the image appears in the My Photos gallery

window. Double-click the thumbnail to view a full-size, high-
resolution scan of the image in the work area.
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11. Click the Send button.

12. Click the To the Internet tab.

13. Click the Web Page button. A new window appears allowing
you to alter the image.

Click the 1Trim tab to select the portion of the image you
want to use. Click OK when finished.

Click the 2Size tab to adjust the size of the image.

Click the 3Reduce tab to convert the image to a lower
resolution to make the image easier to download.

Click the 4Choose tab to convert the image to either JPEG
or GIF format. A Save window appears. Choose a location
in which to save the image. Click the OK button in the
window that appears to continue converting the image to
the format you chose.

14. Click the 5Done tab to finish.

15. Select Quit from the File menu to exit PhotoDeluxe.
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Using Presto! PageManager to Scan a
Form and Edit it with PageType

NOTE: Presto! PageType is not a Macintosh compatible
application. The following procedure is for PC users only.

1. Click on the Start bar in the bottom-left corner of the screen.
2. Click Programs.

3. Select Presto! PageManager.

4. Select Presto! PageManager.

5. The Presto! PageManager window appears.
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6. Choose Select Source from the File menu. A window appears,
choose VistaScan. Select Acquire from the File menu. The
VistaScan Beginner window appears.
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Lift the document cover and place the form you want to scan
facedown in the center of the object glass of the scanner.

Click the Preview button.

Click on the Text/Lineart icon in the Click to Scan area to
begin the scan.

When the scan is complete, click Exit at the bottom of the
window. The scanned image of your form appears in the
PageManager Inbox window.

Choose Save As from the Presto! PageManager File menu.
Select the location where you want to save the image by
clicking on the arrow to the right of the Save in field. This
displays your folder or directory structure. Choose a location by
clicking on it.

Enter the name you would like to save the file as in the File
name field. Click the Save button.

Choose bitmap (BMP) as the format style in which you want
to save the image. (PageType can only open certain format
styles).

Choose Exit from the File menu to close Presto! Page Manager.
Click on the Start bar in the bottom-left corner of the screen.

Click Programs.

Select Presto! PageManager.
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19. Select Presto! PageType. The Presto! PageType window
appears.
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20. Choose Open from the File menu. Enter the name of the
image you saved. The image appears in the client space.
Fill in the form text desired using the PageType tools.

21. Save the image when you have finished editing the form

by selecting Save As from the File menu and entering the
relevant information.

Creating a Calendar with PhotoDeluxe

You can create your own calendar using PhotoDeluxe. This process
differs for PC and Macintosh users. Follow the appropriate
instructions for the system that you are using.

For PC Users:

1. Insert the PhotoDeluxe CD in your CD-ROM drive.

77



NOTE: The PhotoDeluxe CD must be loaded in the CD-ROM
drive to access the calendar templates.

2. Open PhotoDeluxe (refer to Chapter 2. Your First Scan for
instructions on how to start PhotoDeluxe).

3. The PhotoDeluxe window appears.

X
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4. Click the Cards & More button.

5. Click the Calendars icon, and choose the Monthly Calendars
option from the drop-down menu.
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Follow the onscreen instructions through step 5, then click the
Add tab and choose the scanner icon. The VistaScan Beginner
window opens automatically.

Click the Preview button to perform a low resolution scan.

Click on the icon that most closely matches the item you are
going to scan in the Click to Scan area.

The Open Photos dialog box displays a thumbnail version of
the image you scanned.
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Drag the thumbnail from the Acquire section of the My Photos
dialog box to the desired location on the calendar.

Click Save from the File menu to store the calendar page, or
select Print to print the calendar page.

Repeat this process until all the calendar pages are complete.
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For Macintosh Users:

1. Insert the PhotoDeluxe CD in your CD-ROM drive.

NOTE: The PhotoDeluxe CD must be loaded in the CD-ROM
drive to access the calendar templates.

2. Open PhotoDeluxe (refer to Chapter 2. Your First Scan for
instructions on how to start PhotoDeluxe).

3. The PhotoDeluxe window appears.
4. Click the Cards & Calendars tab.

5. Click the Calendars button and follow the onscreen
instructions:

a. Click the 1Calendar tab. Click the Month button. Choose
a month, and then click OK.

b. Click the 2Year tab and select the appropriate year.

c. Click the 3Layout tab. Click the Choose layout button.
Several layouts appear after the computer has had time to
read the information from the CD. Select a layout from the
Template floating window.

d. Click the 4Style tab. Click the Choose Style button.
Double-click one of the styles that appear in the Templates
window.

e. Click the 5Add tab. Click the Scanner button to launch the
VistaScan Beginner window.

f. Click the Preview button, then click one of the icons from
the Click to Scan section.

g. A window appears requesting that you save the document.
Type a name in the field that appears to the right of “Save
this document as:”
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NOTE: By default the image is saved as “untitled - #” in
the Acquire section of the floating gallery window. You
can also choose to save the image in the hard drive or on
the desktop by clicking on the arrow to the right of the My
Photos box at the top of this window.

h. After a moment the image appears in the My Photos gallery
window. Double-click the thumbnail to view a full-size,
high-resolution scan of the image in the work area.

i. Click the Done tab.

6. Drag the thumbnail from the Acquire section of the My Photos
dialog box, to the area on the calendar where you wish to place
the photograph.

7. Select Save As from the File menu to store the calendar page,
or Print to print the calendar page.

Converting Scanned Text to Editable Text
with OmniPage

OmniPage lets you scan an image that contains text and convert it
into editable text so you don’t have to retype the text. The process
differs slightly for PC and Macintosh users. Follow the appropriate
instructions for the system that you are using.

Opening OmniPage LE

For PC Users:

1. Click on the Start bar in the bottom-left corner of the screen.
2. Click Programs.

3. Select the Caere Applications option.

4. Select OminPage LE to launch the application. The OmniPage
LE window appears.
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For Macintosh Users:
1. Double-click the Hard Drive icon.
2. Double-click OmniPage LE.

3. Double-click the OmniPage LE icon. An OmniPage toolbar
appears. (If this toolbar does not appear, click on the Window
menu and select Show Toolbar).

i i File [t Process Settings Window Help
T T I T - = . -
ALTO = I % ek al % E

| Sawn irage ilimr.n iiirmnccniiimnu ﬂ_ll

Chok ™ AUTO " 80 sl emabinsily Soan e recognize pages

-
|

4. Click Select Scanner from the Settings menu. Select UMAX
Astra Series then click OK.
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Converting Scanned Text with OmniPage LE

1.

2.

Position the image you want to scan facedown on the scanner’s
object glass.

From the OmniPage LE window, click the Scanner icon and
select Flatbed. Click Done.

For PC Users:

1.

5.

Choose Acquire Image from the File menu. Select Flatbed
from the Load Scanner dialog box. Then click Scan to scan the
image. When the scan is completed, the text appears in the
OmniPage window.

Click the OCR button to perform the character recognition.

If you have additional pages to scan, click Add Pages and
repeat steps 2 and 3.

Click Stop Scanning when you have scanned all the desired
pages, and enter the file name, file directory and file type (the
format in which you want to save the file).

Click OK to save the recognized text.

For Macintosh Users:

1.

2.

3.

Click Save to save the converted text.
Choose Exit from the File menu to close OmniPage LE.
Open your word processor application. Open the file that you

just saved so you can review, edit, cut or copy portions of the
text.
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Creating an Album with
Presto! PhotoAlbum

A variety of templates are included in Presto! PhotoAlbum that you
can use for albums. You can also save an aloum you create and use
it later as a template for creating another albums. This process
differs for PC and Macintosh users. When a step is different for PC
or Mac users, a note gives platform-specific instructions.

Opening PhotoAlbum:
1. Open the Presto! PhotoAlbum program.

For PC Users:

a. Click on the Start bar in the bottom-left corner of the
screen.

b. Click Programs.

c. Select Presto! PhotoAlbum.

d. Select Presto! PhotoAlbum. The PhotoAlbum window
appears.

For Macintosh Users:

a. Double-click the Hard Drive icon.

Double-click the Presto! PhotoAlbum application folder.

c. Double-click the Presto! PhotoAlbum application icon to
launch VistaScan. The PhotoAlbum window appears.

o
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Creating a Photo Album

1. Click on the Create button, and then click on the Template
button.

2. Choose an album template category by selecting one of the
category icons in the column on the left.

3. Display the available template outlines by clicking on the
template thumbnail. Browse through the template thumbnails
using the scroll bar.

NOTE: Clicking on the thumbnail displays a description of the
layout. The description includes information when the layout
was originally created and how many pages are contained in the
layout.
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When you have chosen a template, click OK. After a moment
the template appears.

Click on the Command icon in the upper-left corner of the
floating Photo Browser window. If this window is not
displayed, click on the Photo Browser button, located on the
left side of the row of three icons on the bottom of the screen.

Choose Select TWAIN Source from the drop-down menu.
Choose VistaScan, then click the Select button.

Click on the Photo Browser window Command icon again,
and then click Acquire to activate the scanner and launch
VistaScan. The VistaScan Beginner window opens.

Lift the document cover and place the image you want to scan
facedown in the center of the object glass of the scanner.

Click on the Preview button to perform a preliminary low-
resolution scan of the photo you want to include in the album.

Specify the area to be scanned in the final scan using the
VistaScan Frame Tool.

Click on the Color Photos icon in the Click to Scan area of the
VistaScan Beginner window. The scanner performs the final,
high-resolution scan.

For PC Users:

After the scan is complete, click the Exit button.

A thumbnail of the image you just scanned appears in the Photo
Browser window.

Click and drag this image into the spaces that read, “Put Photo
Here!”
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14. Repeat this process by scanning more photos and inserting
them in the blank cell photo frames until you have filled the

whole album.

15. Choose the Save As command from the Album menu. Enter
the file name and directory location in which you want to store
the album. Click OK to save the album.
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CHAPTER 5. How to Get Help

The Astra 2000 series scanners have been designed to be reliable,
easy-to-install, and easy-to-use. If you encounter any problems
while installing or using your scanner, please follow the solutions
outlined below.

»  Consult the online manual.
* Read the troubleshooting section below.
* Contact UMAX directly.

Using Online Manuals

All bundled software comes with online help, which essentially is
an online manual. Read the following information to find out how
to access the manuals for each individual software application.

Accessing the UMAX VistaScan Online Manual
For PC Users:

If the VistaScan application is already open, you can locate the
manual by clicking on the user tips that pop up when your mouse
scrolls over a tool. If VistaScan is not open, follow the instructions
below.

1. Click Start.

2. Click Programs.

3. Click VistaScan.

4. Click VistaScan User’s Guide. Your Internet browser should
launch the VistaScan User’s Guide.
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For Macintosh Users:

If the VistaScan application is already open, you can locate the
manual by clicking on the ? icon located in the upper right corner.
If VistaScan is not open, follow the instructions below.

1. Double-click the Hard Drive icon on the desktop.

2. Double-click the UMAX VistaScan folder.

3. Double-click the VistaScan Help. Your Internet browser
should launch the VistaScan User’s Guide.

Accessing the Adobe PhotoDeluxe Online
Manual

For PC Users:

1. Place the PhotoDeluxe CD in the CD-ROM drive. (If the install
screen automatically launches, skip to step 4.)

2. Double-click My Computer.
3. Right-click the CD-ROM drive and select AutoPlay.

4. Click ReadMe & Guide. From here, you can select the manual
best suited to your needs.

For Macintosh Users:

1. Place the Adobe PhotoDeluxe CD in the CD-ROM drive.
2. Double-click the PhotoDeluxe CD icon on the desktop.

3. Double-click English.

4. Double-click Getting Started.pdf. (If you receive an error,

please install Adobe Acrobat Reader 3.01. See “Installing
Acrobat Reader” below for instructions.)
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Accessing the Presto! PageManager Online
Manual

For PC Users:

1. Click Start.

2. Click Programs.

3. Click Presto! PageManager Deluxe.

4. Click PageManager User’s Manual.

For Macintosh Users:

1. Double-click the Hard Drive icon on the desktop.

2. Double-click the Presto! PageManager 2.31.02 folder.

3. Double-click User’s Guide.pdf. (If you receive an error, please

install Adobe Acrobat reader 3.01. See “Installing Acrobat
Reader” below for instructions.)

Accessing the Caere OmniPage Online Manual
For PC Users:

1. Click Start.
2. Click Programs.

Click Caere Application.

ok~ w

Click English Documentation.
For Macintosh Users:
1. Double-click the Hard Drive icon on the desktop.

2. Double-click the OmniPage LE folder.
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3. Double-click OmniPage Ltd.pdf. (If you receive an error,
please install Adobe Acrobat Reader 3.01. See “Installing
Acrobat Reader” below for instructions.)

Installing Acrobat Reader for Macintosh Users

To read the OmniPage LE online manual you need to use Adobe
Acrobat Reader. If it is not already installed on your computer,
follow the installtion instructions below.

1. Place the VistaScan CD in the CD-ROM drive.

2. Double-click the UMAX VistaScan CD icon.

3. Double-click the Acrobat Reader Install folder.

4. Double-click the 3.0 folder.

5. Double-click the Reader folder.

6. Double-click the Install Acrobat 3.0 icon.

Troubleshooting

This scanner is designed to be reliable and easy to install. If you
have any problems with your scanner, please read the notes that
follow to find out probable causes of the problem.

General Problems and Solutions

Problem:
The scanner lamp fails to light, flickers or dims

Solution:
The scanning lamp is failing or has failed and needs to be changed.
Please contact your dealer or UMAX Technical Support.
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Problem:

The scanner text failed. The scanner text utility is a PC-based
utility. Macintosh users will not encounter this problem.

Solution:

Make sure the interface cable (parallel or USB) is properly
connected to the USB connector port, or to the parallel printer port
(not the RS-232 port) on your computer.

Astra 2000U (Windows 98/95 OSR2) Problems
and Solutions

Problem:

Your computer does not recognize your USB scanner

USB support must be installed and enabled or the scanner will not
work. Different USB chipsets have different levels of USB
compliance. The initial USB chipset that was released was the
INTEL82371SB. It supports most low draw devices such as mice

and joysticks, but high draw devices such as scanners might have
trouble functioning on the “SB” chipset.

Later chipset versions include SIS, ALI, and both have many fully
functional chipsets as well as Intel’s 82371AB and 82371AB/EB.

Solution:
To determine your USB chipset type:

1. Click on the “My Computer” icon using the right mouse button.
A pop-up menu appears.

2. Click on Properties command using the left mouse button. This
brings up the Device Manager.

3. The last item listed in the Device Manager should be Universal
Serial Bus Controllers.
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4. Click the + beside the Universal Serial Bus Controllers entry.
Two items display, (your chipset) PCI to USB Open Host
Controller and Root Hub.

If a yellow exclamation point appears, or if one or both of them are
not present, please contact your computer manufacturer. If the USB
section does not show up we recommend you contact your
computer manufacturer to enable USB.

Problem:

IRQ steering is disabled. For USB to function properly, IRQ
Steering must be enabled.

Solution:

The IRQ Steering setting is located in the Device Manager. Follow
the steps below to find out if the IRQ steering is enabled:

1. Click on the “My Computer” icon using the right mouse button.
A pop-up menu appears.

2. Click on Properties command using the left mouse button. This
brings up the Device Manager.

3. In the Device Manager click the + symbol beside the System
Devices item.

4. Double-click the PCI Bus to display the PCI Bus Properties.

5. Click on the tab labeled IRQ Steering.

6. The bottom half of this tab displays the IRQ Routing Status.
Look for the following items:

94

IRQ Routing enabled

IRQ read from (where it is read from)

IRQ Mini-port loaded successfully

IRQ Mini-port data processed successfully
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If you see these items as listed above, IRQ Steering is enabled. If
you do not see the information, contact your computer
manufacturer. USB will not function properly without IRQ
Steering.

Problem:

Scanner is not present in the Device Manager. The scanner must be
present in the Device Manager. If there is no listing for the it, the
scanner will not work.

Solution:

Follow the steps below to determine if the scanner is present in the
Device Manager.

1. Click on the “My Computer” icon using the right mouse button.
A pop-up menu appears.

2. Click on Properties command using the left mouse button. This
brings up the Device Manager.

3. The scanner should be listed under the heading of Imaging
Device.

4. Ifitis not present, insert the UMAX VistaScan CD-ROM into
the CD-ROM drive.

5. Unplug the scanner cable from the back of the computer, and
then plug it back into the USB port.

6. If the scanner does not show up, and there is no change in the
Device Manager, try the another USB port. If the scanner still
does not appear, contact your computer manufacturer.
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Problem:

Your system resources are low. Your system resources are the
amount of free resources your system can call on at a given time.
This should be at 90% or above to run a scanner. Anything under
60% will cause system freezes or link fails when you attempt to
access the scanner.

Solution:

Follow the steps below to determine if your system resources are
too low to operate the scanner.

1.
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Click on the “My Computer” icon using the right mouse button.
A pop-up menu appears.

Click on Properties command using the left mouse button.

Click the Performance tab (the fourth tab under System
Properties).

Look in the System Resources area (the second section). This
number should be above 90%.

If not, Press and hold down the CTRL+ALT keys and tap the
Delete key once. This brings up the Close Programs window.

You need to end all tasks running except the EXPLORER and
SYSTRAY items. To end a task, highlight an item in the Close
Programs window and click the End Task Button. Repeat this
step for each task you want to end.
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Astra 2000U (Macintosh version) Problems and
Solutions
Problem:
When | daisy chain the scanner with other USB capable devices, |
get a scanner error.
Solution:

Many Macintosh computers have at least two USB ports. We
recommend that you connect your scanner directly to one of these
ports. Daisy-chaining the scanner, or running the scanner through a
hub can cause the signal to be lost before it is communicated to
your computer.

To make the troubleshooting process easier, disconnect your
scanner from other USB capable devices or hubs when
troubleshooting.

Problem:

I cannot get the scanner to install properly, or it does not run once it
is installed.

Solution:

If you are having problems installing or using the Astra 2000U
scanner, be sure that Macintosh OS 8.1 or higher is installed on
your computer.

Problem:

The system takes too long to scan.

Solution:

Disable virtual memory, reboot your computer with the extensions
disabled (hold down the SHIFT key during re-boot) and try again.
Booting with the shift key still loads the extension.
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Problem:

Your system goes to the Finder when you try to acquire the
scanner.

Solution:

Plug the scanner into its own power outlet. If still does the same
thing, please call UMAX Technical Support.

Problem:

The following error message appeared: “Error: Not Enough
Power to Function”

Solution:

The Macintosh OS generates this message if:

e A device draws too much power from the USB bus

* One or more devices plugged into a hub require more power
than is available

* You attached a self-powered device (such as a printer or floppy
drive) to your computer without plugging it into an electrical
outlet.

Remove all other devices from the USB chain, so the scanner is the
only device on the USB chain. Make sure that the scanner power
adapter is plugged directly into the wall, not into a power strip.

Problem:

The following error message appeared: “Error: No Driver Found”

Solution:

The Macintosh OS generates this message if it could not find a
driver in the System Folder for the USB device you just connected.
You may have forgotten to install the software that came with the
device, or you may have put the device driver (i.e., the software that
allows Macintosh to recognize and communicate with the USB
device) in the wrong place in your System Folder.
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Re-install the software driver from the VistaScan CD-ROM. Make
sure the extension is loaded and on.

Problem:

The following error message appeared: "Scanner not found" or
"Unable to control scanner"

Solution:
Follow this procedure:

1. Isolate, and plug the scanner in a USB port by itself.
2. Go to the Apple System Profiler, listed under the Apple menu.

3. Go to the Devices & Volumes tab (Command + 2). Is the
scanner listed under the USB tree as:

Class: 0
Product ID: 16
Vendor ID: 5638
4. If no, disconnect the USB cable from the computer.
5. Go to Command, Update All Information (Command + U).
6. Reconnect the scanner, and Update All Information again. Is
the scanner listed? If yes, you can begin scanning. If no, please

call UMAX Technical Support.

Try the following solutions, if you are still experiencing
scanning problems:

1. Plug the scanner power adapter directly into the wall outlet and
not in a surge protector.

2. If using a USB hub, plug the scanner directly into the
Macintosh USB port.
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3. If you are using a Macintosh computer other than the iMac, do
not run the scanner off the keyboard. The keyboard has two
ports. Those ports are for right or left-handed people so they
can plug the mouse in where it is better for them.

4. Download all updates for your Macintosh for USB from the
Apple’s Web site http://www.apple.com

Astra 2000P (Windows 98/95 OSR2) Problems
and Solutions

Problem:

An Anti-Virus program was running while you installed the driver.
Anti-Virus programs by their protective nature automatically think
anything making changes to the system folder is a Virus and takes
appropriate action. In other words it re-writes the data being
installed to ensure it does not infect your system. Normally this is
fine, but if the anti-virus software re-writes the VistaScan driver
file, it does not operate properly.

Solution:
Following these steps to correct the problem:
1. Delete the VistaScan folder from your hard drive along with the

TWAIN, TWAIN32, and Twain_32 folders stored in your
Windows folder.

2. Now you need to shutdown (or End Task) all the background
programs running on your computer. Background programs are
applications that you do not usually see running.

3. Press and hold down the CTRL+ALT keys and tap the Delete
key once. This brings up the Close Programs window.
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4. Highlight all items in the Close Programs window other than
the EXPLORER and SYSTRAY and click the End Task
Button.

5. Now that all of the background programs (including Anti-Virus
applications) are closed, re-install VistaScan

Problem:

Your parallel port mode is set incorrectly. The parallel port mode
can be set using SPP (Standard Parallel Port) or EPP (Enhanced
Parallel Port). If your port is set to SPP, it can only support one
parallel device (usually a printer). EPP mode allows the parallel
port to control more than a single device. To control both the
scanner and the printer using the parallel port you need to change
the port setting to EPP.

Solution:

Follow the steps below to change your parallel port mode, if you
are familiar with editing your BIOS settings:

1. Go to the Peripherals section and find the Parallel Port Mode
setting.

2. Change the setting to ECP or EPP.
3. Save the changes and exit the BIOS.

4. Cycle the scanner power by unplugging the power adapter cord
from your scanner, then plugging it back in to the wall outlet.

5. Reboot into Windows.
At this point, your computer should recognized by your scanner. If

you are still having problems you can try different modes, one at a
time, (cycling the scanner power after each change).
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If you are not familiar with editing your BIOS settings, contact your
computer manufacturer for more information.
Problem:

Your printer driver is conflicting with the scanner. Some printers
ship with proprietary drivers. This means is that the some printer
drivers are set to capture all communication on the parallel port.
This does not allow the scanner to communicate with the computer.
Solution:

Follow the steps below to correct the printer driver conflict:
1. Unplug your printer cable from the back of the scanner.

Important Note: Make sure you have the driver installation
disk for your printer before removing this.

2. Click the Start bar.
3. Choose the Settings option from the pop-up menu.
4. Another pop-up menu appears. Choose the Printers option.

5. Locate your printer and highlight it. Choose Delete from the
File menu.

6. Reboot your computer try the scanner test again.

7. If the scanner passes the test when your printer driver is not on
your system, you cannot use your printer driver on the same
port as the scanner. There are two solutions for this situation.
Most printer companies are aware of this problem and can
provide updated drivers. Checking your printer manufacturer’s
Web site for updated drivers is your fastest solution.

8. If this does not solve the problem, you might want to consider
installing an 1/O card to provide a second parallel port you can
use for your printer.
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Contacting Technical Support

If the above solutions have not resolved your problem, please
contact your dealer or call the UMAX Technical Support
department during regular business hours, Monday-Friday, at (510)
492-5827. Before you call, please be sure to have the following
information ready:

¢ The scanner model and serial number

e The version humber of the scanner driver (located on the front
of the CD)

e The computer model you are using

e The printer and model that you are using (if you have one
hooked up)

* The application software packages that you are using
» Error codes or messages seen

» A description of what you were doing at the time of the
malfunction so that the problem can be recreated

»  Other observations that may aid the technician in identifying
the problem and solution

If at all possible, please be in front of your computer and scanner
with both turned on. Try to have as much description about your
problem as possible. Having this information will allow the
technician to troubleshoot your problem more effectively.

E-mail UMAX with your technical support question at:
support@umax.com or call (510) 492-5827 during regular business
hours, Monday through Friday.
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Maintenance

With the exception of periodic cleaning or lamp replacement, the
scanner is virtually maintenance-free. Please read the following
section to learn how to properly maintain the scanner.

Static Electricity Precautions

Static electricity is a constant danger to computer systems. The
charge that can build up in your body may be strong enough to
damage electronic components on the scanner’s printed circuit
board or the computer’s interface card. Therefore, it is important to
observe basic precautions whenever handling electronic
components for your computer. Although areas with high humidity
are much less prone to static electricity, it is best to always take
precautions against accidental damage that can result in expensive
repairs.

The following measures should generally be enough to protect your
equipment from static discharge.

» Discharge any static electricity that may have built-up in your
body by touching a grounded or anti-static surface. For
example, touch some large metal object or the silver-toned
expansion slot covers at the rear of your computer’s case. Be
sure to do this immediately before removing any components
from their anti-static bags.

*  When handling any electronic components, be sure to carefully
avoid touching any metal part of the component. Avoid
touching any of the gold “fingers” that plug into the expansion
slot. It is best to handle system components either by their
edges or by the mounting bracket which attaches to the slot
opening in the rear of the case.

Follow the above to the best of your ability. Excessive caution is
not necessary, simply take reasonable care.
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Cleaning

Regularly cleaning the object glass will ensure that dirt or smudges
will not reduce the quality of your scanned images. Before you
clean the glass, make sure the scanner is turned off and the power
cord is unplugged.

Clean the object glass and document cover; with a soft damp cloth
and a mild detergent or alcohol.

Warning: Do not spray the cleaning fluid directly on the object
glass. Spraying the liquid directly on the glass may cause the liquid
to penetrate the seams around the glass and contaminate the mirrors
and lenses inside the scanner. Please be sure you spray the liquid on
the cleaning cloth and then wipe the glass clean.
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Appendix A. Technical
Specifications

The following table defines the technical specifications for the
Astra 2000 Series Scanners.

Scanner Specifications

Scanner Type

1-pass color flatbed

Scanning Element

Color CCD

Optical Resolution
Maximum Resolution

600 dpi x 1200 dpi
9600 dpi x 9600 dpi

Color Density

36-bit color

Light Source

Cold Cathode Lamp

Optics

Enclosed Optical System

Interface

Astra 2000P—Parallel
Astra 2000U—USB

Operating System

Astra 2000P—W,indows
95, 98, NT 4.0

Astra 2000U—Windows
95, 98, Mac OS 8.0+ (for
iMac and USB-compatible
Macintosh computers)

Scanning Modes

B/W, halftone, 8-bit
grayscale, 12-bit
grayscale, 24-bit color, 36
bit color

Document Size

Letter, A4, B5, A5, check
size

Scanner Dimensions

18.4"x12.2" x3.9”

Approx. Scanner
Weight

7.8 Ibs.
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Glossary

Additive Primary Colors-Red, Green, and Blue light that produce
white when mixed together. A color monitor or color scanner is an
example of an additive color device.

BET-A UMAX patented technology that increases the dynamic
range and decreases overall noise for improved image quality.

Bit Map Image -An image comprised of pixels, or binary digits,
that can be bi-level (line art), continuous tone gray or continuous
tone color.

Calibration-To check, adjust or standardize the graduations of a
device.

CCD-Charged Coupled Device. An optically sensitive IC chip.
This IC chip is the standard image-capturing tool for many scanners
and digital cameras.

CIS (Contact Image Sensor)-A scanning sensor beginning to appear
in low resolution, low cost scanners. Provides lesser quality scan
then CCD due to limited depth of field and poor shading sensitivity.

CMYK-Represents the three subtractive primary colors Cyan (C),
Magenta (M), Yellow (Y), and Black (K). An offset press is an
example of a CMYK device.

Color Separation-The conversion of RGB or LAB image
information into CMYK information prior to printing.

ColorSync-Built-in color management architecture specifically in
the Macintosh OS.

Color Space-A two or three-dimensional geometric representation
of colors that can be seen or generated. RG13 is an example of a
two dimensional color space. LAB is a three dimensional color
space.
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Continuous Tone-An image that has enough tonal range so that the
human eye can't detect obvious "jumps" or "steps" between gray or
color levels. A photograph is an example of a contone image. A
computerized contone image can only be represented as a bitmap
image.

Descreen-The process of removing a moiré.

Dmin-The lightest area of an image that a device can reproduce and
still have detail. A Dmin value of 0.0 would be considered perfect.
Dmax (-) Dmin=Dynamic range.

Dmax-The darkest area of an image that a device can reproduce
and still have detail. A Dmax value of 4.0 would be considered
perfect. Dmax (-) Dmin=Dynamic range.

DPI (Dots Per Inch)-A standard unit of measurement for scanners
and printers. Scanners are given a DPI rating even though they
create pixels not dots. DPI is also a scanner’s measure of it’s
enlargement capabilities. DPI is not a good measure of a scanner’s
overall image quality.

Dynamic Range-An instruments range, such as a scanner, of
measurable values. The range is from the lowest value it can detect
to the highest value. A perfect dynamic range for a scanner is
considered to be 4.0 or Dmin=0 and Dmax=4. The dynamic range
of a scanner is most indicative of it’s overall image quality with 3.0
being a minimum rating for prepress capable scanners.

Gamma-The range of colors and gray tones that can be interpreted
by a color model, or is generated by a specific device.

Grayscale-The depiction or measurement of all values between
white and black.

Halftone-A combination of spots and dots that create the illusion of
tonality - both for color and continuous tone Black & White. A
newspaper picture is a good example of an image that has been
halftoned.
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Highlight-The brightest part of an image that still has detail.
Setting a highlight point in an image is arguably the most important
step to achieving a good scan.

Histogram-A bar chart that represents the pixel count of an image.
The bar chart has a scale from 0-255, which represents 2 to the 8th
power or 256 levels of gray. All images, even a Polar bear in a
snowstorm should have a histogram that extends from 0 (darkest
area) to 255 (lightest area).

ICC-International Color Consortium

LAB-A color space that most closely resembles the color spectrum
a human eye can perceive. [L] represents the lightness or
luminosity of the image, [A] represents the Red/Green axis, [B]
represents the Blue/Yellow axis. These values are plotted at right
angles to each other in a three dimensional manner.

Linearization-The process of calibrating a scanner’s white point,
50% gray point and black point. This is usually accomplished by
scanning a grayscale target.

Line art-An image having only one level of contrast or (1) bit
depth. A line art image can be either Bitmap or vector.

LPI-Lines Per Inch. Also referred to as line screen. The greater the
LPI the more continuous looking the image will appear to the
human eye. A newspaper is generally printed at 85-100 LPI while
magazines are printed from 133-175 or higher.

OCR (Optical Character Recognition)-A process which assists an
input device in converting pixels to ASCII information.

Pixel-An abbreviation for "Picture Element'. The basic building
block of computer images.
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PMT (Photo Multiplier Tube)-The method of light and image
capture used by drum scanners. This method is considered to be
superior to CCD technology and usually has a higher Dynamic
Range than CCD’s. UMAX CCD technology is moving closer and
closer to PMT technology every day.

Postscript-A device independent image file format. This is the file
format most commonly used to output images or compound
documents, pages with text and graphics, via the four-color process.
Postscript color is currently limited to 24-bit pixel depth or 16.7
million colors. Grayscale PS images are limited to an 8-bit pixel
depth.

PPI (Pixels Per Inch)-This measurement is the same as DPI or Dots
Per Inch. PPI is more indicative of a monitor where DPI is usually
associated with printers and scanners.

Reflective Object-An original image that doesn't allow light to
pass through. A printed photograph is an example of a reflective
image.

Resolution-Refers to how many pixels a device can create or how
many dots a device will reproduce.

RGB-Red (R), Green (G) and Blue (B) or the additive primary
colors.

RIP (Raster Image Processing)-The process of converting pixels to
halftone spots or dots. A RIP can be part of the printer or a separate
computer if speed is of the essence.

Screen-Refers to computerized and non-computerized methods of
converting a continuous tone image into printable patterns. Screen
frequencies are usually referred to as LPI.

SCSI (Small Computer Systems Interface)-Currently the fastest

protocol for transferring information from a peripheral device, such
as a scanner, to the computer.
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Shadow-The darkest part of an image that still has detail. Setting
the shadow point is also an important aspect to achieving a good
scan.

Subtractive Primary Colors-Cyan (C), Magenta (M), and Yellow
(). When these three colors are combined at values of 100% on a
printing press black is produced.

Transmissive Object-image that allows light to pass through. A
35mm slide or negative is a good example of a transmissive object.

UMAX Technologies, Inc.-A company renowned for producing
user-friendly scanners that provide superior image quality, a high
degree of utility to the customer. You can contact UMAX technical
support during regular business hours Monday-Friday at (510) 492-
5827, or by visiting the UMAX web site located at
http://www.umax.com

White Light-A light that theoretically can create the entire visible

spectrum of colors. Cold Cathode lamps are currently the closest
White Light source used in CCD scanner.
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FCC Declaration of Conformity

Declares that the products:
Product Name: Color Scanner Model No.: Astra 2000U
Astra 2000P

FCC Rules: Tested to comply with FCC Part 15, Class B Operating

Environment: For home or office use:

FCC Compliance Statement:

This device complies with part 15 of the FCC Rules. Operation is subject

to the following two conditions: (1) This device may not cause harmful

interference, and (2) This device must accept any interference received,

including interference that may cause undesirable operation.

Information to user:

This equipment has been tested and found to comply with the limits of a

Class B digital device, pursuant to Part 15 of the FCC Rules. These limits

are designed to provide reasonable protection against harmful interference

in a residential installation. This equipment generates, uses and can

radiate radio frequency energy and, if not installed and used in accordance

with the instructions, may cause harmful interference to radio

communications. However, there is no guarantee that interference will not

occur in a particular installation. If this equipment does cause harmful

interference to radio or television reception (which can be determined by

turning the equipment off and on) the user is encouraged to try to correct

the interference by one or more of the following measures:

» Reorient/relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

»  Connect the equipment to an outlet different from the one to which
the receiver is connected.

»  Consult the dealer or an experienced radio/TV technician for help.

Caution:

Changes or modifications not expressly approved by the manufacturer

responsible for compliance could void the user’s authority to operate the

equipment.

The party responsible for product compliance:

Corporate Name: UMAX Technologies, Inc.

Address: 3561 Gateway Blvd., Fremont, CA 94538, USA

Telephone No.:  510-492-5827

Person responsible for making this Declaration:

Position/Title: President Signature: U "__/Iz;
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Warranty

One Year Limited Warranty
UMAX Technologies, Inc. (UMAX) warrants this hardware product against defects in
material and workmanship for a period of ONE (1) YEAR from the original date of purchase.

Should any defect(s) be discovered, the product may be returned either to the manufacturer or
an authorized UMAX service center. If you are returning product for repair, please be sure to
do the following:

1) Call UMAX Technical Support Mon-Fri during regular business hours at (510) 492-5827
and obtain an RMA (Return Merchandise Authorization) number.

2) Clearly write your RMA number on the OUTSIDE of the box or package next to the
shipping label.

3) Include a copy of the bill of sale with the returned product.

4) Unless otherwise instructed, do not return any manuals or software when returning items
for repair.

5) All scanners and transparency adapters need to be locked or restrained prior to transport.
Failure to lock or restrain these items could cause serious damage to the product and void the
warranty.

6) Ship to UMAX via a traceable shipping method and retain the tracking number.

This warranty is only valid within the boundaries and territories of the USA and Canada.
UMAX is not responsible for costs incurred due to shipping, insurance, customs, or duties.
UMAX is not responsible for non-traceable packages or packages shipped without a valid
RMA number on the outside of the package.

This warranty does not apply if the product has been damaged by an accident, electrical fault,
through misuse or abuse. If the product has been altered without written authorization by
UMAX, the warranty will not be applicable.

This warranty applies only to hardware products manufactured by or for UMAX. Warranted
products must bear the “UMAX” brand name, tradename, or logo. The aforementioned
warranty and remedies are exclusive, and in lieu of all others, whether oral, written,
expressed or implied. UMAX specifically disclaims any and all implied warranties of
merchantability and fitness for a particular purpose.

UMAX is not responsible for incidental or consequential damages resulting from any breach
of warranty. UMAX is not responsible under any other legal theory, including, but not
limited to lost profits, and any cost of recovering reprogramming or reproducing any program
or data stored in or used with UMAX products.

For more warranty information, please call UMAX at (510) 492-5827.

Warranty Service

If your UMAX product needs to be returned for repair, you must contact UMAX technical
support or your reseller in Canada prior to shipment for an RMA number before sending in
the product. The RMA number is a Return Merchandise Authorization number. UMAX and
UMAX Authorized Service Centers will refuse all shipments without a proper RMA number.
The RMA number MUST be printed on the outside of the box or package next to the
shipping label. All scanners and transparency adapters must be locked or restrained prior to
transport. Failure to lock or restrain these items could cause serious damage to the product
and void the warranty.
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Index

A

accessing online manuals, 89

Acrobat reader, installation, 92

adjusting brightness, tone, color, 55

Advanced window, 40

album, creating with PhotoAlbum,
84

application, image destination, 34

archiving scanned images, 84

Astra 2000P backpanel, 12

Astra 2000U backpanel, 11

automatic image copies, 63

B

basic scanning information, 29

Beginner window, 35

Beginner window, VistaScan, 35

black and white images, scanning,
42

blurring images, 49

brightness adjustment, 54

C

Caere applications, 81

calendars, creating with
PhotoDeluxe, 77

changing scale factors, 49

changing the document source, 40

checking connectors, 14

choosing a printer, 32

cleaning the scanner, 105

color adjustment, 54

Color Adjustment features, using,
54

color images, scanning, 42

Color Matching/Correction, 30

color saturation, 57

color spectrum wheel, 57

connecting the Interface Cables, 15

connecting the Parallel cable, 16
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connecting the Power Adapter, 17

connecting USB cable, Macintosh,
16

connecting USB Cable, PC, 15

connector types, 14

contents of scanner package, 10

Copy Utility features, 64

Copy Utility, UMAX, 63

creating E-cards, 61

creating Web-ready images, 70

custom descreen settings, defining,
48

custom resolution settings, 46

D

descreen feature, changing, 47
Direct Access, VistaAccess, 59
document cover, 11

driver selection, VistaScan, 25

E

E-cards, creating, 61

E-mail applications, 33

e-mail preferences, 31

e-mail scanned images, 33

e-mailing a scanned image with
VistaScan, 69

F

fax preferences, 31

fax scanned images, 33

FCC information, 115

File icon, 32

file size and resolution, 44

file storage location, 26

filter setting, changing, 48

forms, scan and edit with PageType,
75
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Frame Selection tool, 37
frame selection, removal, 54

G

General Preferences tab, 29
getting to know your scanner, 11
glossary, 109

grayscale adjustment, 51

H

hardware installation, 13

help, how to get, 89

help, technical support, 103

how to get help, 89

how to scan a photo to e-mail, 69

how to scan and print with
VistaScan, 67

iMac cable connection, 16

image destinations, 38

image placement, 23

image tone adjustment, 57

image type, 23

image type settings, 39

image types you can scan, 41

installing Acrobat reader, 92

installing ATM, 19

installing Microsoft Internet
Explorer, 19

installing OmniPage LE, 20

installing PhotoDeluxe, 18

installing PhotoDeluxe, Macintosh,
19

installing Presto! PageManager, 20

installing Presto! PageType, 20

installing Presto! PhotoAlbum, 20

installing the Hardware, 13

installing the Software, 18

installing VistaScan, 20

interface connectors, 15
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J

job list window, 54

L

launching PhotoDeluxe, 21
light/dark settings adjustment, 51

M

Macintosh installation,
PhotoDeluxe, 19

Macintosh Requirements, 13

MagicMatch, 30

maintenance, 104

Move tool, 38

moving an image, 37

Multiple Frame tool, usage, 53

multiple scan mode, 53

O

object glass, 11

OCR, optical character recognition,
42,81

OmniPage LE, installing, 20

OmniPage online manual,
accessing, 91

OmniPage, scanning and editing
text, 81

online browser, 23

online manuals, 89

opening PhotoDeluxe, 21

optimal resolution settings, 44

P

package contents, 9, 10

package contents, Astra 2000P, 10
package contents, Astra 2000U, 10
parallel cable, 16

parallel connector, 9

parallel connectors, 14

parallel port, 14

photo gallery, 26



PhotoAlbum, creating an album
with, 84

PhotoDeluxe installation, 18

PhotoDeluxe online manual,
accessing, 90

PhotoDeluxe, creating a calendar,
77

PhotoDeluxe, make Web images, 70

PhotoDeluxe, opening, 21

power adapter, connecting, 17

power indicator, 11

Power Saving utility, 27

Presto! PageManager online
manual, 91

Presto! PageManager, installing, 20

Presto! PageType, installing, 20

Presto! PhotoAlbum, installing, 20

Preview button, 23

Preview scan, how to, 36

Preview tools, Beginner window, 37

print preferences, 31

printers, choosing, 32

printing scanned images, 32

problems and solutions, 92

protect your scanner from static
electricity, 104

Q

Q & A troubleshooting section, 93,
100

R

removing a selected frame, 54

resizing an image, 37

resolution and file size, 44

resolution settings, 43

resolution settings, recommended,
44

resolution, changing the, 43

rotating an image, 58

S

Save As window, 24
save to application preferences, 31
save to file preferences, 31

UMAX Astra 2000U/P Owner’s Guide

scaling images, 49

scan and automatically print images,
63

Scan Control Unit features, 52

Scan Destination, 31

scan destinations, advanced, 52

scanner cleaning, 105

scanner connectors, 13

Scanner Information tab, 34

scanner lamp, turning it off and on,
27

scanner specifications, 107

scanner test, 22

scanning an image, 23

scanning an image, how to, 23

scanning and printing with
VistaScan, 67

scanning basics, 29

scanning features, VistaScan
Advanced, 40

scanning reflective objects, 41

scanning, first time, 21

screen savers, how to make, 61

selecting a directory to save in, 24

selecting image destination, 38

selecting image type, 39

selecting multiple frames, 53

selecting scan destinations,
advanced, 52

selecting the area of an image, 37

sending images to applications, 34

setting up the scanner, 14

setting VistaScan preferences, 29

shadows, mid-level tone adjustment,
57

sharpening image lines, 49

Show Ruler, 31

software installation, 18

specifications, scanner, 107

static electricity precaution, 104

System Requirements, 12

system requirements, Astra 2000P,
13

system requirements, Astra 2000U,
12

119



T

testing the scanner, 22

Tips Help, 31

tone adjustment, 54

tools, VistaScan Beginner window,
37

troubleshooting, 92

turning the scanner lamp on and off,
27

U

UMAX Technical Support, 103

unpacking the scanner, 9

USB cable, 15

USB connector, 9

USB Connectors, 13

USB port, 14

using custom resolution settings, 46

using custom scale settings, 50

using PageType to scan and edit
forms, 75

using PhotoDeluxe to make web
images, 70

using VistaAccess, 59

120

using VistaScan to scan a photo to
e-mail, 69

using VistaScan to scan and print
images, 67

\

VistaScan Beginner window, 23, 35

VistaScan driver selection, 25

VistaScan features, Advanced
window, 40

VistaScan features, Beginner
window, 35

VistaScan online manual, accessing,
89

VistaScan, installing, 20

VistaShuttle, usage, 61

W

wall paper, how to make, 61
warranty, 116

Y

your first scan, 21
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